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How This Guide Is Organized
F-Secure Mobile Anti-Virus for Pocket PC User’s Guide describes how to 
install and use F-Secure Mobile Anti-Virus for Pocket PC. It is divided into 
the following chapters and appendices:
Chapter 1.  Introduction. Provides general information about the 
functionality and features of F-Secure Mobile Anti-Virus for Pocket PC.

Chapter 2.  Installation. Explains how to install F-Secure Mobile 
Anti-Virus for Pocket PC.

Chapter 3.  User Interface. Describes the F-Secure Mobile Anti-Virus 
user interface.

Chapter 4.  Startup and Shutdown. Explains how to start and shut down 
F-Secure Mobile Anti-Virus.

Chapter 5.  Configuration. Gives instructions on configuring the scanning 
and update settings.

Chapter 6.  Virus Scan. Explains how to scan files for viruses.

Chapter 7.  What to Do If a Virus Is Found. Explains how to view details 
of infected files and what to do if a virus is found.

Chapter 8.  Updating. Explains how to keep F-Secure Mobile Anti-Virus 
up-to-date.

Chapter 9.  Troubleshooting. Provides solutions to common problems.

Technical Support. Provides the contact information for assistance.

About F-Secure Corporation. Describes the company background and 
products.
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Conventions Used in F-Secure Guides
This section describes the symbols, fonts, and terminology used in this 
guide.

Symbols

⇒ An arrow indicates a one-step procedure.

Fonts
Arial bold (blue) is used to refer to menu names and commands, to 
buttons and other items in a dialog box.

Arial Italics (blue) is used to refer to other chapters in the manual, book 
titles, and titles of other manuals.

Arial Italics (black) is used for file and folder names, for figure and table 
captions, and for directory tree names.

Courier New is used for messages on your computer screen.

WARNING:  The warning symbol indicates a situation with a 
risk of irreversible destruction to data.

IMPORTANT:  An exclamation mark provides important information 
that you need to consider.

REFERENCE - A book refers you to related information on the 
topic available in another document.

l

NOTE - A note provides additional information that you should 
consider.

TIP - A tip provides information that can help you perform a task 
more quickly or easily.
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Courier New bold is used for information that you must type.

SMALL CAPS (BLACK) is used for a key or key combination on your 
keyboard.

Arial underlined (blue) is used for user interface links.

Times New Roman regular is used for window and dialog box names.

PDF Document
This manual is provided in PDF (Portable Document Format). The PDF 
document can be used for online viewing and printing using Adobe® 
Acrobat® Reader. When printing the manual, please print the entire 
manual, including the copyright and disclaimer statements.

For More Information
Visit F-Secure at http://www.f-secure.com for documentation, training 
courses, downloads, and service and support contacts.
In our constant attempts to improve our documentation, we would 
welcome your feedback. If you have any questions, comments, or 
suggestions about this or any other F-Secure document, please contact 
us at documentation@f-secure.com.

http://www.f-secure.com
documentation@f-secure.com
mailto:documentation@f-secure.com
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1.1 F-Secure Mobile Anti-Virus for Pocket PC
In this guide, F-Secure Mobile Anti-Virus for Pocket PC is referred to as 
F-Secure Mobile Anti-Virus.

F-Secure Mobile Anti-Virus is an antivirus program that protects data 
stored on your Pocket PC against malicious code attacks. It automatically 
scans all files when they are accessed. When F-Secure Mobile Anti-Virus 
detects an infected file, it immediately quarantines it to protect all other 
data on your Pocket PC. 

For the F-Secure Mobile Anti-Virus application to work effectively, you 
must keep it up-to-date. You can keep the application up-to-date by 
downloading the latest virus definition databases and application 
upgrades automatically from your update server. 

1.2 Key Features
F-Secure Mobile Anti-Virus has the following key features:

Extensive scanning The application automatically scans all files when they are accessed (if 
you have selected real-time scanning). Viruses are scanned on your 
Pocket PC so it is protected from malicious code even if you transfer 
programs from other Pocket PCs or PCs that do not have antivirus 
software installed. You can also manually scan your Pocket PC for 
viruses whenever you want.

Automatic Updates The application automatically downloads regular updates to keep the 
virus definition database up-to-date (if you have selected automatic 
updates). This enables finding and removing even the most recently 
found viruses and ensures that you always have the best possible 
protection. F-Secure Mobile Anti-Virus also offers the possibility to receive 
updates using a wireless connection (GSM/GPRS dial-up or WLAN).
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2.1 System Requirements
To use F-Secure Mobile Anti-Virus, your Pocket PC must meet the 
following minimum requirements:

You can install F-Secure Mobile Anti-Virus also using your computer. To 
do that, you must have Microsoft ActiveSync 3.5 or later installed on your 
computer. If you have an earlier version, you can download the latest 
version from the Microsoft Pocket PC website,  
http://www.Microsoft.com/PocketPC/

2.2 Installing F-Secure Mobile Anti-Virus
You can install the application in one of the following ways:

Directly on your Pocket PC; see “Direct Installation”, 17
By connecting your Pocket PC to your computer and using Active 
Sync; see “Installation Using Your Computer”, 17

Table 2-1: Pocket PC Requirements 

Operating System: Windows Mobile 2003 software for Pocket 
PC, 
Windows Mobile 2003 Second Edition 
software for Pocket PC, or
Windows Mobile 2003 Second Edition 
software for Pocket PC Phone Edition

Supported devices: QTEK 9090 (Windows Mobile 2003 
Second edition Pocket PC phone edition)
T-Mobile MDA compact (Pocket PC 2003 
SE Phone edition)
MDA II (Pocket PC 2003)
MDA III (Windows Mobile 2003 Second 
edition Pocket PC phone edition)

http://www.Microsoft.com/PocketPC/
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Installation
2.2.1 Direct Installation
For installing the application directly on your Pocket PC:
1. Transfer the installation file (.cab file) to your Pocket PC.
2. In File Explorer, locate the application installation package. 
3. Tap the .cab file to start the installation process. The installer 

automatically places all the application components into the correct 
folders.

4. After installing the application, you are prompted to restart your 
Pocket PC. Tap Yes.

5. After you restart your Pocket PC, the Product Activation wizard is 
launched. Follow the instructions on the screen. For more information 
on activating the application, see “First-time Start-Up (Activation)”, 26.

2.2.2 Installation Using Your Computer
For installing the application on your Pocket PC using a computer, you 
must have the .exe file on the computer.

To install F-Secure Mobile Anti-Virus using a computer:
1. Run the installation program manually by tapping the F-Secure 

Mobile Anti-Virus .exe file.
2. If your Pocket PC is connected to the computer, the ActiveSync 

pushes the installation files to your Pocket PC and installs all 
application components into the correct folders
If your Pocket PC is not connected to the computer during the 
installation process, the ActiveSync installs the application 
components during the next ActiveSync session.

3. After installing the application, you are prompted to restart your 
Pocket PC. Tap Yes.

4. After you restart your Pocket PC, the Product Activation wizard is 
launched. Follow the instructions on the screen. For more information 
on activating the application, see “First-time Start-Up (Activation)”, 26.
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2.3 Uninstalling F-Secure Mobile Anti-Virus

You can uninstall the application either directly from your Pocket PC or 
through a computer using ActiveSync.

To uninstall the application from your Pocket PC:
1. Close the application by tapping Exit on the File menu.
2. On the Start menu, tap Settings, and then tap Remove programs.
3. Tap Yes when you are prompted if you want to uninstall the 

application.
All the application components are removed.

To uninstall the application using your computer:

1. Close the application by selecting Exit on the File menu.
2. All the applications that have been installed using ActiveSync appear 

on the ActiveSync application list. To view the list of installed 
applications, click Add/Remove Programs on the ActiveSync Tools 
menu.

3. From the list of installed applications, select F-Secure Mobile 
Anti-Virus, and click Remove.
All the application components are removed.

IMPORTANT: If you need to uninstall the application from your 
Pocket PC, make sure that you do not have any quarantined or 
infected files in your Pocket PC.

IMPORTANT: If you installed the application locally on your Pocket 
PC, you can uninstall it only using ActiveSync.
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3.1 Main View
The F-Secure Mobile Anti-Virus main view displays:

Real-time scanning status
Update status
Subscription status
Infection status

Figure 3-1  Main view
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User Interface
3.1.1 Main View Buttons
The main view has two buttons:

Scan All - scan all files on your Pocket PC for viruses
Activate (available if activation has not been completed) - 
activate the application (first-time start-up), OR

Update (available if activation has been completed) - download 
the latest update

3.1.2 Main View Menus
The menus on the main view are:

File menu
Update menu
Tools menu

File Menu
The File menu has the following commands:

Scan all - scan all files on your Pocket PC for viruses
Infections... (available if there are infections in the system) - 
open the Infected files view
Exit - shut down the application

Tapping the  icon at the top right corner of the main view hides the 
user interface, but keeps the application running on the background. If 
you have selected real-time scanning, all files are automatically scanned 
for viruses when they are accessed.

IMPORTANT: If you shut down the application, the infected files 
are not quarantined and the system is not protected against 
viruses.
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Update Menu
The Update menu has the following commands:

Activate Anti-Virus (available if activation has not been 
completed) - activate the application (first-time start-up)
Update... (available if activation has been completed) - download 
the latest update
Subscribe (available if activation has been completed) - display 
the Subscribe screen

Tools Menu
The Tools menu has the following commands:

Settings - edit the Anti-Virus configuration
About - display information about the application, such as 
copyright information and the software version

3.2 About Anti-Virus
The About Anti-Virus view displays the following information:

Application version information
Scanner version
Copyright information
URL to F-Secure Corporation's international web page

Depending on how and where you purchased the product, 
the Update menu may have either a Subscribe or Cancel 
Subscription command.
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3.3 Today Screen
After the application has been successfully started, a status icon 
(F-Secure logo) is displayed at the bottom of the Today screen 
(Figure 3-2). The status icon indicates if your Pocket PC is protected. 

⇒ Tap the F-Secure status icon to bring F-Secure Mobile Anti-Virus into 
view.

Figure 3-2 Today screen
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4.1 Starting F-Secure Mobile Anti-Virus
After successfully installing the application, you need to activate it 
(first-time start-up). For more information about the activation, see 
“First-time Start-Up (Activation)”, 26. 

Next time when you turn on your Pocket PC, the application starts up 
automatically (normal start-up). If you have selected real-time scanning, 
the real-time scanner is started. You should scan all files to ensure your 
Pocket PC is clean. We also recommend scanning your Pocket PC 
whenever prompted by the application. For more information about the 
normal start-up, see “Normal Start-Up”, 30

4.1.1 First-time Start-Up (Activation)
Activating F-Secure Mobile Anti-Virus is a three step process:

Step 1. Start the Activation Process, 26
Step 2. Get an Activation Code, 27
Step 3. Update F-Secure Mobile Anti-Virus, 28

Step 1.Start the 
Activation 

Process

After you have installed the application and restarted your Pocket PC, the 
Product Activation Welcome screen is displayed. Tap Yes to start the 
activation process

If files are missing or corrupted, or there is not enough memory to 
start the application, an error message is displayed. For more 
information, see Chapter 9. Troubleshooting.
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Step 2.Get an 
Activation Code

There are three ways to activate the antivirus update subscription. Select 
one of the following options that is displayed on your Pocket PC:

Activate the free evaluation period. Tap the Free Evaluation 
button and tap Next. 

Purchase an activation code from the F-Secure eStore. Open the 
website http://www.f-secure.com/estore, find the link for 
F-Secure Mobile Anti-Virus and purchase an activation code. 
Type the activation code into the boxes and tap Next.
If your mobile phone was given to you by your work, contact your 
Information Technology department and they can provide you 
with a activation code. Type the activation code into the boxes 
and tap Next.

When the 30 day free evaluation period is over you must 
reactivate your service account with a subscription 
number.
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Step 3.Update 
F-Secure Mobile 

Anti-Virus

1. A new virus definition database is downloaded automatically.

Figure 4-1 Product Activation Wizard - Checking for updates

The Product Activation screen displays the following icons:

Table 4-1: Product Activation Screen Icons

Icon Description
The task is currently active.

The task has been completed successfully.

The task has failed because of an error.
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2. If an application upgrade is available, tap Yes to download it. Tap No 
to continue the activation process without downloading the upgrade.

3. When the download is complete, a screen informs you that the 
activation is complete and the virus protection is up-to-date.

Figure 4-2 Product Activation Wizard - Activation completed

If the virus definition database version requires an application 
upgrade, it is downloaded automatically.

If the application could not connect to the update server, the 
updating failed, or the subscription could not be 
authenticated, an error message is displayed. For more 
information on update errors, see Chapter 9. 
Troubleshooting.
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4. If new updates were downloaded, you will be prompted to scan your 
Pocket PC. Tap Yes.

4.1.2 Normal Start-Up
Normal start-up is executed when you open the application after 
successfully completing the activation. The application starts 
automatically when you switch on your Pocket PC. During the start-up 
process, the application checks whether the virus definition database is 
up-to-date.

If there were known infections when F-Secure Mobile Anti-Virus was last 
running and you chose not to delete the infected files, next time you start 
F-Secure Mobile Anti-Virus, you are prompted to run a full scan. 

To start F-Secure Mobile Anti-Virus:

1. Open the application by tapping Start Programs   Anti-Virus.
2. If you are prompted to run a virus scan, press Yes.

4.2 Shutting Down F-Secure Mobile Anti-Virus

To shut down F-Secure Mobile Anti-Virus:
1. From the File menu, select Exit.
2. In the Confirm Exit message, tap Yes to shut down the application.

We strongly recommend scanning your Pocket PC whenever 
prompted by the application.

Tapping No cancels the query and takes you back to the 
main view.

WARNING: By shutting down F-Secure Mobile Anti-Virus, you 
exit the application. After you exit the application, the system 
is not protected against viruses as you cannot use real-time 
scanning and keep the infected files in the quarantine.
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4.3 Hiding User Interface
Hiding the user interface keeps the application running in the background.

To hide the F-Secure Mobile Anti-Virus user interface:
⇒ Tap the  icon on the main view. The application user interface is 

hidden. Hiding the user interface allows you to use real-time scanning 
and to keep the files in the quarantine.
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5.1 Overview
Configuring F-Secure Mobile Anti-Virus involves setting up the 
configuration options that help you protect your Pocket PC against 
viruses and harmful content in all file types. Correctly configured, 
F-Secure Mobile Anti-Virus detects and deletes all malware that enters 
your Pocket PC through wireless IP connectivity, infrared connections and 
removable memory cards. The configuration options include settings for:

Real-time scanning - check the box to select real-time scanning
Automatic updates - check the box to select automatic updates

5.2 Setting Configuration Options
To set the configuration options:
1. Open the Settings screen by selecting Settings from the Tools 

menu.
2. On the Settings screen, select the desired options:

Real-time scanning - check the box to set the application to 
automatically scan files for malicious content when files are 
accessed or modified.
If you select real-time scanning, the application runs in the 
background, and when a virus is found in a file, it is immediately 
quarantined and added to the file list for further processing. 
Automatic updates - check the box to set the application to 
automatically download updates.

3. Tap the  icon at the top right corner.

IMPORTANT: You must have an active connection to the Internet 
for the application to check for updates. The application does NOT 
open a connection itself

You can manually update F-Secure Mobile Anti-Virus 
whenever you want by selecting Update from the Main 
View



6
 VIRUS SCAN

Overview.....................................................................................  36
Scanning Options .......................................................................  36
Running a Manual Scan .............................................................  37
Viewing Scan Results.................................................................  38
35



36  
6.1 Overview
F-Secure Mobile Anti-Virus is configured to provide you with complete 
protection against malicious code attacks. If real-time scanning is 
enabled, when the data on your Pocket PC is accessed or modified, the 
application automatically scans it for malicious content. 

F-Secure Mobile Anti-Virus detects all malware that enters your Pocket 
PC through wireless network and infrared connections, and removable 
memory cards. If you want to make sure there are no infected files in your 
Pocket PC, you can manually scan all the data for viruses whenever you 
want.

6.2 Scanning Options
There are two scanning options you can use: real-time and manual 
scanning:

Real-time scanning (recommended) - set the application to 
automatically scan files for malicious content when they are 
accessed or modified. When you select real-time scanning, the 
application runs in the background. When a virus is found in a file, 
the file is immediately quarantined and added to the file list for 
further processing. 

Manual scanning - manually run a full scan on your Pocket PC.

IMPORTANT: If you do not select real-time scanning, you should 
remember to run a manual scan each time you transfer new data to 
your Pocket PC.

IMPORTANT: If you do not select real-time scanning, you should 
remember to run a manual scan each time you transfer new data to 
your Pocket PC.
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6.3 Running a Manual Scan
To run a manual scan:

1. Start the application by tapping the Start Programs  
Anti-Virus. 

2. Do one of the following:
In the main view, tap the Scan all icon.
On the File menu, tap Scan All.

3. The F-Secure Mobile Anti-Virus scans all the data on your Pocket PC.

Figure 6-1 Scanning for Viruses

4. When scanning is complete, the scanning results are displayed.
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6.4 Viewing Scan Results
When scanning is complete, the scanning results are displayed. If viruses 
were detected during scanning, you are prompted to view the infections. 
For more information on viewing infections, see “Viewing Details of 
Infected Files”, 44.

Figure 6-2 Scan for Viruses - Scanning results
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An icon appears in the Scanning Results screen. See the table below for 
more information.

The Scanning Results screen displays the following statistics:

6.4.1 Viewing List of Not Scanned Files
To view the list of not scanned files:

⇒ In the Scanning Results screen (Figure 6-2), tap the View link on the 
Not Scanned line. The Not Scanned Files screen (Figure 6-3) is 
displayed.

Table 6-1: Scanning Results Screen Icons

Icon Explanation

No infections were detected.

Infections were detected.

Scanning was stopped by user.

Scanned: The number of the files that were scanned.

Infected: The number of the infections found. For more 
information about removing infected files, see “What to 
Do If a Virus Is Found”, 48.

Not scanned: The number of the files that were not scanned during 
the scan. A file cannot be scanned if another program is 
using it during the scan.

The View link is visible only if infections were detected during 
scanning.
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6.4.2 Viewing Details of Not Scanned Files
To view the details of not scanned files:
1. In the Not Scanned Files screen, tap a file and then tap the Details 

button.

Figure 6-3 Not Scanned Files

2. The Not Scanned File Details screen (Figure 6-4) is displayed
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Figure 6-4 Not Scanned File Details

The following information is displayed on the not scanned file:
File name
Folder
Size
Dates when the file was:

Created
Modified
Accessed

Other information, for example, whether the file has been locked 
by another process.

3. Tap the  icon to return to the Not Scanned Files screen
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7.1 Overview
F-Secure Mobile Anti-Virus works in the background and scans your files 
automatically. When it finds a virus in a file, the infected file is 
automatically quarantined. The quarantined file is locked up and cannot 
be accessed. You can afterwards delete or release the infected file. If you 
delete an infected file, it is removed completely. If you release an infected 
file, it is not quarantined any more and the system is not protected from 
the viruses the file contains.

7.2 Viewing Details of Infected Files
To view details of the infected file(s):
1. If the application detects viruses during a scan, you are prompted to 

view the detected infection(s).

2. Tap Yes to view the infected file(s), or No to close the view.

The Infected Files screen (Figure 7-1) contains a list of infected files 
on your Pocket PC. The first column of the text indicates the name of 
the infected file and the second part shows the state of the file 
(quarantined, released).

You can view the infections also by tapping the View link in the 
Scanning Results screen.

If only one infected file is detected, the Infected File Details 
screen (Figure 7-3) is displayed.
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Figure 7-1 Infected Files

You can find in-depth virus descriptions in the F-Secure web 
site: http://mobile.f-secure.com/

http://www.F-Secure.com/v-descs/
http://mobile.f-secure.com/
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3. Tap and hold the name of the infected file, and tap Details on the 
pop-up menu.

Figure 7-2 Infected Files - View details
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4. The Infected File Details screen displays the name of the infected file, 
the full path, a list of infections that the file contains, and if the file has 
been quarantined.

Figure 7-3 Infected File Details 
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7.3 What to Do If a Virus Is Found
When F-Secure Mobile Anti-Virus finds a virus in a file, you can process 
the infected file(s) in one of the following ways:

To process infected files:
1. In the Infected Files screen, tap the check box next to the name of the 

infected file that you want to process.

2. Tap one of the buttons at the bottom of the screen to select the 
desired action:

Delete - a confirmation message prompts you to confirm the 
deletion.
Quarantine
Release - a confirmation message prompts you to confirm 
releasing the file.

3. Tap the  icon to return to the main view.

Action Description

Delete The file is removed.

Quarantine The file is locked up and cannot be accessed when 
F-Secure Mobile Anti-Virus is running in the background. 

Release The file is not quarantined any more and the system is not 
protected from the viruses it contains. Be aware of the 
risks involved in releasing infected files.

IMPORTANT: If F-Secure Mobile Anti-Virus finds viruses in your 
e-mail, remember to delete the infected attachments also from 
Microsoft Outlook on your computer.

Alternatively, you can tap and hold the name of the infected 
file, and select the desired action from the pop-up menu.
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8.1 Overview
You can keep F-Secure Mobile Anti-Virus up to date by downloading the 
latest virus definition databases and application upgrades from antivirus 
update server. The virus definition database contains information of all the 
viruses that the application can find during the scan. If you have selected 
automatic updates, F-Secure Mobile Anti-Virus downloads new updates 
daily when it detects an open Internet connection. You can also manually 
download the updates.

Only an up-to-date virus definition database enables finding and 
removing even the most recently found viruses, and ensure you the best 
possible protection.

8.2 Viewing Update Information
You can see the date of the last update on the application main view 
(Figure 8-1).

IMPORTANT: You must have an active connection to the Internet 
for the application to check for updates. The application does NOT 
open a connection itself.
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Figure 8-1 Main view

The following information is displayed:

Real-time scanning The status (enabled/disabled) of 
real-time scanning.

Update The date of the last update.

Subscription The expiration date of the antivirus 
service. You should renew your 
subscription prior to the expiration.

Infections The number of infections detected.

Your F-Secure Mobile Anti-Virus includes a license. When your 
license is valid, you can freely update your F-Secure Mobile 
Anti-Virus. When your license expires, you can update your 
F-Secure Mobile Anti-Virus only after renewing your license.
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8.3 Updating F-Secure Mobile Anti-Virus
You can run a manual update, or you can set an automatic update. You 
need an active connection to the Internet for checking updates.

8.3.1 Automatic Updates
When you have selected the Automatic Update feature, the application 
downloads new updates daily when it detects an open Internet 
connection. 

For information about selecting automatic updates, see “Setting 
Configuration Options”, 34.

8.3.2 Manual Updates
To run a manual update:
1. Do one of the following to launch the Update wizard:

Tap the Update icon on the main view.
From the Update menu, select Update.

IMPORTANT: You must have an active connection to the Internet 
for the application to check for updates. The application does NOT 
open a connection itself.
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2. The Update Wizard Confirm Update screen is displayed. Tap Yes to 
connect to the update server.

Figure 8-2 Update Wizard - Confirm Update

3. The application connects to the update server and downloads the 
latest virus definition database. The application takes the virus 
definition database update into use immediately. 

4. If a new application upgrade is available, you are prompted to 
download it. Tap Yes to download the upgrade or No to continue 
without downloading it.

If the application upgrade is required, you are not prompted to 
download the upgrade, but it will be downloaded automatically.
If you select not to download the upgrade, only the virus 
definitions database update is downloaded.
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Figure 8-3 Update Wizard - Application Upgrade Available

5. After you have completed downloading new updates, you are 
prompted to scan your Pocket PC. Tap Yes to run a full scan. For 
information on scan results, see “Viewing Scan Results”, 38.
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9.1 Questions and Answers
Q. How do I know that the application is working?

A. You can copy the EICAR antivirus test file into your Pocket PC. The 
test file is not a virus. After the virus scan, you should be informed 
that the EICAR Test File was found. You can download the test file 
from http://www.eicar.com/. 

Q. Do I lose all my data when I delete an infected application?

A. It depends on the infected application and the infection. You do not 
lose any data that the infected application kept in a separate 
database. Only the application will be deleted and after you reinstall it, 
you can continue to use the application as usual. However, in some 
cases you might lose some of your data, so back up your files 
regularly.

9.2 Not Enough Memory to Start the Application
Q. I receive a ‘Not enough memory to start the Anti-Virus’ message 

during the application startup. What should I do?

A. Close some applications and try again.

9.3 Application Unable to Start Because Some Files 
Are Missing or Corrupted

Q. During the application startup, I receive an ‘Anti-Virus is unable 
to start because some files are missing or corrupted’ message. 
What can I do?

A. This message is displayed when a resource or application file, or files 
required for updating antivirus are missing. Reinstall the product to fix 
the problem and then try again.

http://www.eicar.com/
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9.4 Unable to Connect to Update Server/Update 
Failure

Q. I am unable to get the updates. What can I do?

A. Check the Internet access point settings with your operator. You 
should also check that the date and time settings in your Pocket PC 
are correct.

9.5 Update Service Could Not Authenticate Your 
Pocket PC

Q. I get a notification that the antivirus service is unable to transfer 
subscription to my Pocket PC. Why?

A. This error message is displayed when the update server cannot 
authenticate the subscription. Reasons for the authentication failure 
can be as follows:

You have accessed the F-Secure Mobile Anti-Virus installation 
folder files.
There have been more than four attempts to move the F-Secure 
Mobile Anti-Virus installation and service subscription to another 
Pocket PC.

The Internet access point settings are operator-specific.
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9.6 Service Has Expired or About to Expire
Q. What should I do when one of the following messages appear on 

my Pocket PC screen?

Figure 9-1 Service Expired or About to Expire

A. If your subscription has expired or is about to expire, the application 
notifies you by showing one of the above messages. 

If your subscription has expired and you want to renew it, press Yes 
to purchase more subscription service time. The other message 
simply reminds you that your subscription is going to expire in a 
number of days. The message will disappear in few seconds. 

The subscription options are operator-specific.
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9.7 Virus Definition Database Corrupted or Missing 
and Virus Protection Not Updated

Figure 9-2 Virus Definition Database Corrupted or Missing

Q. My virus definition database seems to be corrupted or it has not 
been updated for x days. What should I do?

A. You should immediately update your virus definition database. After 
that, from the Tools menu, select Settings, tap to select the Enable 
real-time scanning option, and then tap the .icon.
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Overview
F-Secure Technical Support is available by e-mail or from our Web site. 
Please include the following information with your support request:

The version number of any F-Secure product (including the build 
number).
The name and the version number of your operating system 
(including the build number).
The Pocket PC handheld model name.
A detailed description of the problem, including any error 
messages displayed by the F-Secure Mobile Anti-Virus for 
Pocket PC, and any other details, which could help us reproduce 
the problem.

Web-Based Support
The F-Secure Support Center can be found at http://www.F-Secure.com/
support/ and our wireless site at http://www.F-Secure.com/wireless, which 
has more detailed information about Pocket PC related issues.

Electronic Mail Support
You can request technical assistance from 
Handheld-Support@F-Secure.com.

If you have questions about F-Secure not covered in the manual or 
on-line services at http://www.F-Secure.com/, you can contact F-Secure  
Corporation directly, either from our web site or by sending us e-mail.

http://www.F-Secure.com/support/
http://www.F-Secure.com/wireless
mailto:Handheld-Support@F-Secure.com
http://www.F-Secure.com/


About F-Secure Corporation
F-Secure Corporation is the fastest growing publicly listed company in the 
antivirus and intrusion prevention industry with more than 50% revenue 
growth in 2004. Founded in 1988, F-Secure has been listed on the Helsinki 
Stock Exchange since 1999. We have our headquarters in Helsinki, Finland, 
and offices in USA, France, Germany, Italy, Sweden, the United Kingdom and 
Japan. F-Secure is supported by service partners, value added resellers and 
distributors in over 50 countries. F-Secure protection is also available through 
mobile handset manufacturers such as Nokia and as a service through major 
Internet Service Providers, such as Deutsche Telekom, France Telecom and 
Charter Communications. The latest real-time virus threat scenario news are 
available at the F-Secure Antivirus Research Team weblog at  
http://www.f-secure.com/weblog/.

Services for Individuals and Businesses
F-Secure services and software protect individuals and businesses against 
computer viruses and other threats coming through the Internet or mobile 
networks. Our award-winning solutions include antivirus and desktop firewall 
with intrusion prevention, antispam and antispyware solutions. Our key 
strength is our proven speed of response to new threats. For businesses our 
solutions feature a centrally-managed and well-integrated suite of solutions 
for workstations and servers alike. Focused partners offer security as a 
service for companies that do not wish to build in-house security expertise.

Visit our website at http://www.f-secure.com/products/ to learn more about our 
products and services.

http://www.f-secure.com/weblog/
http://www.f-secure.com/products/
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